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Installing EarMaster

Step 1
Insert the EarMaster CD in your CD-ROM drive. 
If the setup program does not launch automatically then select “Run” from the Start menu 
and type “d:setup.exe” where “d:” is the letter of the CD drive.

Step 2
When installation program has started you will be asked to enter your serial number. The 
serial number is placed above the CD in the EarMaster box or is printed on the top of your 
license agreement card.

Step 3
When the serial number is  the installation begins. Follow the on screen instructions.

To install EarMaster School in a network, please find the network installation guide in 
appendix A.

Getting started with EarMaster

EarMaster offers 10 ear training  areas. 
They are listed in the ”Exercises” menu. Each 
exercise consists of a number of windows which 
are chosen from the submenu to the exercise 
menu. 

The “Exercise” window is where you do the 
exercises. 

In the “Exercise setup” window you can make 
your own settings for the exercise. These 
settings can be saved in your own .ear level 
files.

In the “Results” window you can view and compare current 
results with all previous results.

In the “User overview” (which is only visible to 
teachers in the School version), you get a 
summary of results for several users.

You can also choose the exercises 
and the associated 
windows from the 
toolbar:

In the following sections you can read more 
about each exercise and the windows 
belonging to them.

validated

exercise
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Interval comparison

Which interval is the greater?

EarMaster plays two intervals randomly chosen from among 
the selected intervals.

Click on 'A' if the first of the intervals was greater or 'B' if the 
last was greater. The frame around the chosen answer will 
change color. Green if the answer is correct. Red if the 
answer is wrong.

Press 'Play question' to play the intervals again.

You can always get detailed information of your current results and compare it with previous 
results, in the "Results" window.

Related topics:
e Setup chords, intervals and scales 
e Theory on Intervals 

Identification of Intervals, Chords and Scales

The Chord, Interval and Scale exercises work the same 
way.

EarMaster plays a random chord chosen from among the 
selected chords and transposed to a randomly chosen key. 
Your job is to identify what was played.
Basically you can give your answer in two ways: either 
directly give the name of the chord or name each tone you 
heard. However,  there are several ways you can do this 
(see frame on the next page).

Press:
'Play question' to play the question again.
'Play selected' to play your answer (the tones you have entered).
'Answer' when you have entered the tones and want EarMaster to evaluate your answer.

If your answer is wrong, EarMaster will indicate your answer with a red color and the correct 
answer with a green color.
You can always get detailed information of your current results and compare it with previous 
results, in the "Results" window.

Related topics:
e Setup chords, intervals and scales 
e Theory on Intervals 
e Theory on Chords 
e Theory on Scales 



Answer options

In the note based exercises (Interval, chords, melody, etc) you have several options for 
entering the answer. They are found in the “Answer input” menu, where you can show 
and hide each of them:

Notesheet - to enter a tone, press and hold the left mouse button. Move the mouse 
Up/Down to changes the tone, Right/Left to sharpen (#) or flatten (b) the tone. Click the 
right mouse button to cycle through different note values and the rubber (tie). 
Name - Click once on the button with the name of the played tones (interval, chord, etc). 
Left click to select and play the tones without giving it as the answer to EarMaster. Right 
click to select the tones and give this as your answer.
Piano - Left click to select tones, right click to deselect tones. You can change the 
instrument sound and volume in the green display.
Guitar - Left click to select tones, right click to deselect tones.

Use the microphone to sing tones or clap rhythms. In the “Answer input” menu you can 
start and stop the microphone recording.

You can select tones and play rhythms on your external MIDI instrument. You can also 
assign special tones to special functions (like play the bottom C to press the New 
question button), to remote control EarMaster.

6

Chord progressions

EarMaster plays a chord progression. Your job is to identify 
the harmony functions (scale degrees) and quality of the 
chords that were played.
Basically you can give your answer in two ways: either 
directly give the name of the chord progression or give 
each chord you heard. In the "Answer input" menu you can 
show and hide the different answer options:

Notesheet - in this exercise you cannot use the note sheet 
to give your answer. Instead it is used to show your answer. 
Click in one of the bars to play the chord and to move the 
orange cursor to this bar.  
Just below the notesheet you will find a panel where you can specify the quality of the chord. 
If you click on a chord in the notesheet (to move the orange pointer), you can change its 
quality on these buttons and hear the sound of it at the same time.

Name - Click once on the button with the name of chord progression. Left click to select and 
play the tones without giving it as the answer to EarMaster. Right click to select the tones 
and give this as your answer. 
Piano - the harmony functions in the current key are shown on the piano. Left click to insert a 
chord in the position where the orange cursor is shown in the notesheet, right click to remove 
the chord. You can change the instrument sound and volume in the green display.
Guitar - the harmony functions in the current key are shown on the guitar. Left click to insert 
a chord in the position where the orange cursor is shown in the notesheet, right click to 
remove the chord.  
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Press
'Play question' to play the question again.
'Play selected' to play your answer (the chords you have entered).
'Answer' when you have entered the chords and want EarMaster to evaluate your answer.

If your answer is wrong, EarMaster will indicate your answer with a red color and the correct 
answer with a green color.
You can always get detailed information of your current results and compare it with previous 
results, in the "Results" window.

Related topics:
e Setup chords, intervals and scales 

Rhythm reading and Rhythm imitation  

Rhythm reading: EarMaster shows a rhythmic score. You 
clap it following the metronome.
Rhythm imitation: EarMaster plays a rhythm. You repeat it 
following the metronome. After your first attempt you can 
choose to view the rhythm to support you in a second 
attempt.

You can either tap the rhythm on the space bar, play the 
rhythm on a MIDI instrument or clap into the microphone. 
Microphone recording is enabled in the "Answer input" 
menu.

In the rhythmic score you will see a symbol below each 
note:
ü If the note was hit correctly.
ï If you hit the note a bit too early.
ð If you hit the note a bit too late.
û If you did not hit the note at all.

Notice: EarMaster also evaluates how precise the rhythm 
was clapped, so you might not get 100% even though you 
got all the notes.
You can always get detailed information of your current results and compare it with previous 
results, in the "Results" window.
The difficulty level and length of the rhythm can be set in the exercise setup.

Related topics:
e Rhythm exercise setup 

Rhythm correction

Find differences between a transcribed rhythm and a played rhythm.

EarMaster shows a rhythmic score. When you press 'Play changed', EarMaster will play the 
shown rhythm but with a few changes. Only three types of changes are possible:
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• one note is divided into two notes.
• two notes are joined together.
• two notes are exchanged.

You select all the notes involved in the changes. A note is 
selected with a mouse click on it. A second click will 
deselect it. 
When all notes are marked click 'Show changes'. This will 
show both the played rhythm and the correct selections.

You can always get detailed information of your current results and compare it with previous 
results, in the "Results" window.
The difficulty level and length of the rhythm can be set in the exercise setup.

Related topics:
e Rhythm exercise setup 

Melody dictate

What tones are played?

EarMaster plays a phrase according to the settings in the 
setup. Your job is to identify which tones were played and 
transcribe them using the note sheet, piano or guitar (see 
the description in the “Identification of Intervals, Chords and 
Scales” section).

Press 
'Play question' to play the phrase again.
'Play selected' to play your answer (the tones you have entered).
'Answer' when you have entered the tones and want EarMaster to evaluate your answer.

You can always get detailed information of your current results and compare it with previous 
results, in the "Results" window.

Related topics:
e Setup Melody dictate 

The options menu

The available options in the “Options” menu depends on the active exercise.
MIDI all notes off - send an All notes off controller message to the selected MIDI out device.
MIDI reset controllers - send an All Controllers Off message to the selected MIDI out 
device. This message set all controllers (like Hold pedal, Mod wheel, Effects, etc) to their 
default state.
MIDI remote - activate the MIDI in remote control of the exercises. Each button is assigned 
to a MIDI tone as specified in the Program settings.
Automatic new question - if checked you will automatically get a new question when you 
have answered a question. In the Program settings, you can set the delay in seconds and 
other options.



9

Show metronome - activate the visual metronome.
Play metronome - activate the metronome sound.
Rhythm with metronome - enable metronome sound while a rhythm is played. This does 
not influence the metronome sound in the lead in count and while answering the rhythm.
Note identification - specify how EarMaster should interpret your answer. Absolute: You 
must enter the tones exactly as they were played, Any octave: You must enter the same 
tones, but you may transpose them to any octave, Relative: You may transpose your answer 
freely. (e.g. if the question was the perfect fourth interval C-F, you may enter the tones D-G 
as the correct answer). 
Show keyname - if checked, Earmaster will show the name of the key in the note sheet. 
This option is only available if the “Show key signature” option is enabled in the exercise 
setup.

Setup chords, intervals and scales

The tone setup panel - click to include/exclude the 
element (chord, interval, etc) in the exercise. The first 
elements (red text) are predefined and cannot be edited, 
but below those you can add your own. If the text is green, 
the name and tones can be edited.
Root movement - set an upper and lower limit for the root 
and specify how the root should be chosen within this limit.
Playstyle - choose how you would like the tones to be 
played: Harmonic, Melodic up, Melodic Down. If several are 
selected, the style will be chosen randomly. 
Auto answer - EarMaster will automatically press the 
Answer button when the correct answer is selected.
Common tone - the two intervals will be played with the same root tone. 
Show first tone - EarMaster will select the first tone (or bottom tone in harmonies) of the 
answer for you.
Show Key signature - choose whether the key signature should be shown permanent 
instead of adding sharps and flats for each note.
Play tone on click - enable sound on the piano, guitar and note sheet.
Play tonic - play some tones before the question to put you into the tonality.
Diatonic roots - the interval is transposed within the key so that it will always consist of 
diatonic tones.
Inversions - choose how the chords are inverted: 
1) All chords in root position
2) Last chord in root position. The preceding chords will be inverted to a position with the top 
tone closest to the top tone of the last chord.
3) Random inversion of last chord. The preceding chords will be inverted to a position with 
the top tone closest to the top tone of the last chord.
Add root basstone - adds the root tone of the chord at the bottom.
Lock answerinput - to control how the user answers the questions, e.g. when making a 
tutor.

Related topics:
e Interval comparison 
e Identification of Intervals, Chords and Scales 
e Chord progression identification 
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Rhythm exercise setup

The rhythms are generated by EarMaster using an 
intelligent algorithm according to the selections described 
below.

Click to include:
• specific note values and triplets in the rhythm.
• rests and dotted notes. The note values are the same 

as selected above.
• tied notes.
Choose:
• the time signature of the rhythm.
• the number of bars in a row.
• the speed of the rhythm (beats per minute).

Corrections - specify the maximum number of changes to be made in each question.

Show rhythm second time - shows the rhythm automatically when you have finished 
clapping. This will remain visible to support you if you make a second attempt.

Evaluation - choose how precise the rhythm has to be clapped. On Kind a general idea of 
the rhythm is enough while on Severe you must be very precise and have a sharp rhythmic 
'feeling'.

Related topics:
e Rhythm imitation
e Rhythm reading
e Rhythm correction

Setup Melody dictate

The melody phrases are generated by EarMaster using an 
intelligent algorithm according to the selections described 
below:

Tones - the length of the phrase.
Scale/progression - choose a scale, mode or chord 
progression to base the melodic phrase on.
Maximum interval - the maximum interval between two 
adjacent tones.
Ambit - the maximum interval from the lowest tone in the 
phrase to the highest tone in the phrase. 
Tone limits - the total area in which the phrases can be placed.
Key signatures - the key signatures in which the phrase will be generated.

Rhythms - Include rhythmic values in the melodic phrases. When answering a question you 
need to transcribe both the pitch and the note length. Only whole, half and quarter notes will 
be included.
Auto answer - EarMaster will automatically press the Answer button when the correct 
answer is selected.
Show first tone - EarMaster will select the first tone (or bottom tone in harmonies) of the 



answer for you.
Show Key signature - choose whether the key signature should be shown permanent 
instead of adding sharps and flats for each note.
Play tone on click - enable sound on the piano, guitar and note sheet.
Play tonic - play some tones before the question to put you into the tonality.
Lock answerinput - to control how the user answers the questions, e.g. when making a 
tutor.

Related topics:
e Melody dictate

Results

In the Results window  you can view and compare all 
results from the currently selected exercise area. 
With the top buttons you can turn on and off the elements 
you want to view:
• Date and time where the exercise was started.
• Duration - the total time this exercise has been active 

(visible)
• Answer time - the total time you spend on thinking 

what the answer was and answering the question. 
This is the sum of time from each question has been 
set until you answered it.

• Level name - the name of the exercise file or the tutor-step.
• Details - specific results for each chord/interval.

Notice: results are only saved if you have answered at least 5 questions. Every time results 
are reset, you have the option to save the results or not to save the results.

In the status panel at the bottom, you can view summation statistics for a time period. You 
can change the time period in the "View" - "Result summations" menu.
The "Average answer time" is the average for each question - so a few seconds should be 
enough…

The EarMaster Tutor

The EarMaster tutor will lead you through a variety of graded ear training 
exercises and will challenge you according to your skills. It can also be 
replaced by other tutors made with the tutor editor in EarMaster School.

To start the tutor, choose “Tutor” from the “File” menu. When you have answered a number of 
questions, the tutor will evaluate your result and suggest either to advance to the next step, 
repeat the step once more or to go back to the previous step. 
You can jump among all 10 exercises in EarMaster and come back to the tutor where you left 
off. You can stop the tutor anytime by choosing “Tutor” from the “File” menu once again.

Notice: You cannot go to the exercise setup while a tutor is running. Also, to edit a tutor or 
create a new one, you need the tutor editor which is only included in “EarMaster School” and 
the tutor editor is only available if you have teacher or administrator rights.

11
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Import and export of user results

With the import/export function in the “File” menu you can import and export assignments 
(tutor) and results to and from a diskette. Then you can export your results and import them 
on another computer, e.g. if your teacher wants to view the result of your homework. 

The typical use of this function would be when the school has EarMaster School 4 installed 
and students also have any edition of EarMaster 4 installed at home:

1. A teacher creates an exercise course or some assignments and puts them in a tutor. (only 
in EarMaster School)
2. The tutor is assigned to a class or individual users. (only in EarMaster School)
3. Each user exports the settings to a diskette before he/she goes home from school.
4. The student imports the exercise at home.
5. Before going to the next music class, the student exports the result to a diskette and 
imports it at the school.
6. The teacher can view, compare and print the homework results of his class. (only in 
EarMaster School)

Using the microphone

EarMaster offers you to use a microphone to clap, sing or play answers on your favorite 
instrument. Using a microphone makes ear training more interactive - and fun!
No special hardware is required. Just plug a microphone into your sound card. 
EarMaster uses advanced Sound-2-midi technology to analyze the input from the 
Microphone.

Pitch input
Wave-to-MIDI can listen to your singing and work out which note you have sung. However 
recognizing the correct pitch depends very much on the overtones of your voice or 
instrument. Sometimes an overtone is stronger than the fundamental tone and then it will be 
the overtone EarMaster recognizes.
Older computer processors may not have enough processing power to use the microphone 
pitch recognition. If you haven’t enough processor power you may not get reliable results.

Rhythm input
In the rhythm reading and rhythm imitation exercises you can clap the rhythm in the way you 
are used to and prefer: with your hands or with a drum. 
As background noise, microphone sensitivity and sound card amplification can vary a lot,  
you might need to adjust the Rhythm input sensitivity in the program settings to get optimum 
results on your system.

Setting up the Microphone in the Windows mixer
In the Windows mixer, the microphone device needs to be selected for recording. Load the 
mixer by double clicking on the speaker icon in the Windows task bar. Change to recording 
properties by selecting Properties from the Options menu, and then selecting "Adjust volume 
for: recording.” The Microphone device should be checked (have a tick next to it), in the list of 
volume controls. Then press OK. The “Select” box for the microphone device must be 
checked; if it is not, click on “Select” to check it.
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Theory on intervals

Intervals are the most fundamental part of ear training. All harmonies or melodies can be 
considered as a collection of intervals. As a beginner you should therefore begin with 
Intervals and later continue with, for example, Melody dictate to identify a sequence of 
intervals, or Chord identification to identify harmonies with more than two tones.

An interval is the distance in pitch between two tones. It is labeled by its numerical value and 
its quality. The numerical value indicates the number of tones of the diatonic scale it includes. 

The quality can be Perfect, Diminished, Augmented, Major, or Minor.

Unison, fourth, fifth and octave are called perfect intervals. Each of them can be diminished 
(one chromatic tone smaller) or augmented (one chromatic tone larger).
The rest of the intervals within an octave are: second, third, sixth and seventh. Each of them 
can be major or minor.
Below is an example of a Perfect, diminished and augmented fifth and a major and minor 
third.

In EarMaster you can hear the intervals in the Interval identification exercise when you click 
on the button with interval name on it. Notice, “by name” must be enabled in the “Answer 
input” menu to do this.
You can also hear the intervals when you right click on them in the exercise setup.

Recognizing intervals
There are two common ways of recognizing intervals:

1. Use the opening of a well known song. Find songs that begins with each of the Intervals. 
When you hear the interval you will make the connection between the interval and the song. 
See examples of template melodies in the next section.
This method is however criticized because it doesn’t consider the function of the interval 
within the key i.e. the perfect fourth from C to F has a different function (sound) in the C 
major key and the F major key and therefore this method will be difficult to use when doing 
sight reading.

2. Sing up and down a scale to find the matching interval. This method is closely related to 
the solmization system (using the syllables do, re, mi, fa, sol, la, ti, do) which is often used 
when learning sight reading. EarMaster shows the solmization syllables in brackets when 
entering notes in Interval identification and Melody dictate.

Related exercises in EarMaster:
e Interval comparison 
e Interval identification
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Template melodies for intervals

These are examples of songs you can use to recognize specific intervals

ndMinor 2 Isn't she lovely (Stevie Wonder)
ndMajor 2  Happy birthday, Strangers in the night
rdMinor 3   Georgia on my mind
rdMajor 3   Morning has broken

thPerfect 4   Amazing graze, Love me tender
Tritone Maria (West side story) 

thPerfect 5  Wise men say (Can't help falling in love)
thMinor 6   When Israel Was In Egypt’s Land
thMajor 6 NBC theme
thMinor 7   Somewhere (West side story) 
thMajor 7  Bali Hai (South Pacific) 3rd note

Octave Somewhere over the Rainbow

Theory on scales and modes

“Scale” means ladder in Latin. A scale is the tonal basis of music i.e. a set of tones from 
which you build melodies and harmonies. The tones in the list are arranged in order of their 
pitch. Since this tonal basis varies in different periods and countries there are a large number 
of scales.

The major scale, minor scale and the church modes are all based 
on the diatonic scale. They consist of the same tones but the 
center tone (tonic) is different.
The C major scale look like this:

The dorian church mode contains the same tones but the root 
tone is D:

In the same way the Phrygian church mode has the root tone E. Lydian has the root tone F, 
Mixolydian has the root tone G, Natural minor (Aeolian) has the root tone A and Locrian has 
the root tone B.

Recognizing scales
A scale is a sequence of small intervals - usually tones (whole step) and semi-tones (half 
step). To identify a scale you need to know the unique sequence for this scale. 
Scales based on the diatonic scale will always consist of 5 tones and 2 semi-tones. 
Therefore recognizing these scales can be simplified to identify the position of the two semi-
tones.

In EarMaster you can hear the scales in the Scale identification exercise when you click on 
the button with the scale name on it. Notice, “by name” must be enabled in the “Answer 
input” menu to do this.
You can also hear the scales when you right click on them in the exercise setup.

Related exercise in EarMaster:
e Scale identification 
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Theory on chords

A chord is the simultaneous sounding of three or more tones - usually built on superposed 
thirds. Chords are defined by their root note, their quality (major, minor, augmented, 7, etc) 
and eventually by their inversion.

Triads
A chord of three notes consisting of a root and the third and fifth above it.

• Major - has a major third and a perfect fifth
• Minor - has a minor third and a perfect fifth
• Diminished - has a minor third and a diminished fifth
• Augmented - has a major third and an augmented fifth

The first two are called consonant and the last two dissonant chords.

Below the C major, C minor, C diminished and C augmented are transcribed:

Seventh chords
These chords are triads with still another diatonic third superposed.

th• (Dominant) 7 - is a major triad with a minor 7  added.
th• Minor 7 - is a minor triad with a minor 7  added.

th• Dim 7 - is a diminished triad with a diminished 7  added.
th• Half dim - is a diminished triad with a minor 7  added.

thThere are more triad+7  combinations than mentioned here. You can find them in the chord 
definition table in the exercise setup of the Chord identification exercise.

Inversions
The original position of a chord with the root note at the bottom is called the root position. 
When the third of the chord (e.g. E in a C major triad) is at the bottom it is said to be in first 
inversion. When the fifth of the chord (G in a C major triad) is at the bottom it is said to be in 
second inversion.
Below is shown the C major chord in root position, 1. inversion and 2. inversion:

Chord progressions
A series of chords played in a row. When identifying chords within a progression, the main 
task is to find its harmonic function within the key i.e. compare the chord to the tonic which is 
played before the progression. The harmonic functions are written with the roman numerals I, 
II, III, IV, etc, which denotes the degree within the scale.
Each of the seven degrees of the major and minor scale can serve as the root of a triad. The 

 



triads on the “tonal” degrees of the scale, I, IV and V, are the most important for establishing 
the tonality of a piece.
Below is shown the seven degrees of a C major scale:

I (C major), II (d minor), III (e minor), IV (F major), V (G major), VI (a minor), VII (b dim)

rd th thIn minor keys, EarMaster always denotes the 3 , 6  and 7  step as bIII, bVI and bVII to avoid 
rdconfusion because the steps are different. E.g. III is a major 3  above the root in a major key 

rdwhile in a minor key it is a minor 3  above the root and therefore it is denoted as bIII.
 
To identify chord progressions it is a great help to listen to the bass tone which is usually the 
root of the chord. Notice that several chord progressions can have the same root movement 
but different quality of the chords. You can disable the root tone in EarMaster to make it 
harder for you to recognize it.

Related exercises in EarMaster:
e Chord identification 
e Chord inversion identification 
e Chord progression 

Tutor editor
(Only available for teachers in EarMaster School)

With this function you can setup a complete ear training course 
once, and for all. It can easily be distributed to other computers. 
A tutor is actually a set of exercise setups. To define a tutor, you 
simply make a list of exercise setups, add titles and descriptions 
to each of them and define how well a student must perform to 
advance to the next exercise setup (step) in the list.
In the step-list you see all defined steps in the current exercise. 
The steps are defined separately for each exercise.

Add steps
Right click in the step-list to add and remove steps, and to edit 
properties of the selected step. You can find additional help in 
the corresponding windows.
You can easily verify the progression of the steps: Click once on 
each step and view its settings in the exercise setup window.

Edit step
To change the texts and percentage rate, you can either right click on the step and choose 
properties from the menu or simply double-click the step.
The exercise setup for the step can also be edited: click once on the step to update the 
exercise setup window with the setup from this step. When you have made the needed 
corrections in the exercise setup window, right-click the step in the step list and choose 
“Update from setup window”. This will save the setup to the step.
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Insert tutor
To insert steps from another tutor, find the “Insert tutor” function in the “File” menu. This will 
append all the steps from the selected tutor to the end of the step list in the current tutor. The 
steps are only added to the step list in the selected exercise, the step lists in the other 
exercises are not affected.
When the steps have been added, you can drag them with the mouse to the positions where 
you want them.

Userdefined chords
If you define new chords while you are in tutor edit mode, they are only defined for this 
specific tutor. They are loaded and saved together with this tutor.
When you exit the tutor edit mode, EarMaster loads the set of chords that was available 
before you entered the tutor edit mode. 
This means you can define new chords for a specific tutor without affecting the normal set of 
user defined chords.

Users overview
(Only available for teachers in EarMaster School)

With the user-list window you can view all users or a group 
of users and a summary of their settings and results.
The result summary is calculated for the selected exercise. 
You can change the summary time period in the menu 
“View” - “Result summations”.
To refresh and recalculate all user results, choose 
“Refresh” in the “View” menu.

Right-click in the user-list for a menu to add and remove 
users, and to set properties for a user.
This can also be done from the main-menu “Users” where you, in addition, can choose the 
“View list” to view a group of users.
Users are grouped together by putting them in a Class.

To view detailed results for a single user, go to the “Results” section for the exercise.
To view and print selected detailed results for several users, press the printer button to 
invoke the report generator.

Class configuration and maintenance
(Only available for teachers in EarMaster School)

A class enables you to group a number of users together. It 
is needed when you want to view or print user results from 
a selected subset of all users.

To create a new class: 
Choose “Class maintenance…” from the “File” menu. Press 
the “New” button. Give the class a name, attach a teacher 
and eventually a tutor to it. Press “Add/Remove…” to 
connect students to the class.
Notice: deleting a class will not delete the users from the system. It will only disconnect the 
users from the class.
Classes are used with the reports function and the Users overview function.
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Appendix A

Installing EarMaster School in a network

1) Install EarMaster on the server
We recommend that you install EarMaster School on the server. A more advanced solution is 
to install EarMaster School on a client computer (step 2) and then just copy the 
“EarMaster School\Data\” directory to the server. This has to be done before you run 
EarMaster the first time (step 3). 

We strongly recommend that all computer save users settings and results in one place (on 
the server). Then users only have to be added to the system once, and all computers with 
EarMaster installed will remember settings and results for each user.

2) Install EarMaster on the classroom computer (called a "client")
Now you are ready to install EarMaster on your first client computer. We recommend that you 
install it from  but you can also install 
directly from the CD-ROM. 

Tip: It will make life a little easier for you if you copy the CD-ROM to the server and install it 
from there.

3) Running EarMaster School the first time
When running EarMaster the first time you will be asked three questions:

Question I: You are asked if installation should work together with another computer in a 
network - answer Yes! 
The next screen will ask for location of the files. Find the \Data\ directory on the server and 
press Ok. Don't worry about doing something wrong - you can change this later (see step 4).

Question II: Secondly you will be asked if EarMaster should use the Windows login to identify 
users. If all users have their own login in Windows - Answer Yes!
EarMaster will then get this username from Windows to identify what user settings to load. If 
you answer No, EarMaster will show a login window every time it is started (see step 5).

Question III: Finally you will be asked to add an "Administrator" user in EarMaster.
If you answered No in Question II you must remember the username and password entered 
here because only the Administrator can give other users "Teacher" and "Administrator" 
rights.

If you answered Yes in Question II then you cannot enter a username and password. Instead 
EarMaster will create the Administrator with the same username as the current Windows 
username.

4) Check that all client installations share the same server files
It is very important that you verify that all computers use the \Data\ directory on the server 
before you are trying other networking and user administration features in EarMaster. To 
check the settings for the \Data\ directory for each client please go to "Options" and then 

http://www.earmaster.com/download/Earscl4rsetup.exe

Note: Question III should only be asked once for the whole network system. If a new client 
asks for an "Administrator" again then this client has not been configured correctly (see 
Question I).



select "Administration" in the EarMaster program. In "Datafiles" tab verify that it points to the 
\Data\ directory on the server.

When you install EarMaster School on a client it will always install a local set of the data files 
in the \Data\ subdirectory. To avoid confusion we recommend that you remove the \Data\ 
directory from all client computers, and only keep the files on the server.

5) Using Windows login
If each user of the network have their own login to Windows then there is no need to type it 
again when running EarMaster. Go to "Administration" in EarMaster (in the "Options" tab) 
and enable "Use Windows login". EarMaster will then automatically logon with your Windows 
username. 

The user must be created as a user in EarMaster and the username in EarMaster must be 
the same as the one you use for Windows login. If “Allow new users” is enabled in the 
“Options” tab then the user will be created automatically the first time the users runs 
EarMaster.

6) Adding students & assigning user rights
New users can add themselves to EarMaster. Even when using the Windows login they still 
have to be created as users in EarMaster. New users that are added to EarMaster always 
have "Student" rights with the fewest possible rights. By default new users can NOT:

- change the tutor and beginning level that have been assigned to them. (If no tutor has been 
assigned to the student by a teacher then the tutor cannot be used at all.)
- go to the exercise setup where individual configurations are made.
- make user defined chords, intervals and scales.
- access the "Program settings" in the Options menu.

These rights have to be given to the student afterwards by a Teacher or an Administrator. 
User rights and other user properties (like username) can be changed for any user in the 
"User overview" screen. Only the Administrator can give other users "Teacher" and 
"Administrator" rights.

7) Make a shared folder for shared exercise files
If a teacher makes exercise setups or tutors that are assigned to students or should be 
accessible by students then they must be saved in a shared folder that can be accessed by 
all computers.
The administrator must tell EarMaster where the shared folder is. In the Options - 
Administration window on the Options tab, you can enter the "Common files directory".
Notice that the path you enter is read by all computers. Therefore it must be entered in a way 
that is valid for all computers using EarMaster.
If the drive name to the shared folder is not the same on all computers you must instead use 
the format: \\computername\sharename\path
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Appendix B

LICENSE AGREEMENT 
FOR EARMASTER SOFTWARE

IMPORTANT: This EarMaster License Agreement is a legal agreement 
between you (either an individual or a single entity) and MidiTec for the 
EarMaster software product identified above, which includes computer 
software and may include associated media, printed materials, and 
”online” or electronic documentation (”SOFTWARE PRODUCT”). By 
installing or otherwise using the SOFTWARE PRODUCT, you agree to be 
bound by the terms of this license agreement. 

SOFTWARE PRODUCT LICENSE
The SOFTWARE PRODUCT is protected by copyright laws and international copyright 
treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT 
is licensed, not sold. 

1. GRANT OF LICENSE. This license agreement grants you the following rights: 

! Applications Software. You may install and use the SOFTWARE PRODUCT, or in its place, any 
prior version for the same operating system, on as many computers as the number of licenses 
purchased (see the “Licenses” section above). The primary user of the computer on which the 
SOFTWARE PRODUCT is installed may make a second copy for his or her exclusive use on a 
portable computer.

! “Site License” and “Home User License”. A “Site License” allows unlimited use of the 
SOFTWARE PRODUCT at one campus/physical entity and allows all employees to install the 
SOFTWARE PRODUCT on their private computer. A “Home User License” in addition to a Site 
license allows all users to install one copy of the SOFTWARE PRODUCT on a private computer.

! Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a 
storage device such as a network server, used only to install or run the SOFTWARE PRODUCT 
on your other computers over an internal network; however, you must acquire and dedicate a 
license for each separate computer on which the SOFTWARE PRODUCT is installed or run from 
the storage device. A license for the SOFTWARE PRODUCT may not be shared or used 
concurrently on different computers. 

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 

! Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT.

! Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse 
engineer, decompile. or disassemble the SOFTWARE PRODUCT. 

! Software Transfer. You may permanently transfer all of your right under this license agreement, 
provided you retain no copies, you transfer all of the SOFTWARE PRODUCT (including all 
component parts, media and printed materials, any upgrades and this license agreement), and 
the recipient agrees to the terms of this license agreement. If the SOFTWARE PRODUCT is an 
upgrade, any transfer must include all prior versions of the SOFTWARE PRODUCT.
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! Not for Resale Software. If the SOFTWARE PRODUCT is labeled ”Not for Resale” (NFR) then, 
notwithstanding other sections of this license agreement, you may not resell, or otherwise 
transfer for value, the SOFTWARE PRODUCT.

3. UPGRADES. If the SOFTWARE PRODUCT is labeled as an upgrade, you must be properly 
licensed to use a product identified by MidiTec as being eligible for the upgrade in order to use the 
SOFTWARE PRODUCT. A SOFTWARE PRODUCT labeled as an upgrade replaces and/or 
supplements the product that formed the basis for you eligibility for the upgrade.

4. COPYRIGHT. All title and copyrights in and to the SOFTWARE PRODUCT (including but not 
limited to any images, animations, audio, music and text incorporated into the SOFTWARE 
PRODUCT), the accompanying printed materials and any copies of the SOFTWARE PRODUCT 
are owned by MidiTec. The SOFTWARE PRODUCT is protected by copyright laws and international 
treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any other copyrighted 
material except that you may install the SOFTWARE PRODUCT within the limitations of this 
license agreement provided you keep the original solely for backup or archival purposes.

LIMITED WARRANTIES

LIMITED WARRANTY. MidiTec warrants that the SOFTWARE PRODUCT will perform substantially 
in accordance with the accompanying user documentation for a period of 90 days from the date of 
receipt. Any implied warranties on the SOFTWARE are limited to 90 days. Some jurisdictions do not 
allow limitations on duration of an implied warranty, so the above limitation may not apply to you.

CUSTOMER REMEDIES. MidiTec's entire liability and your exclusive remedy shall be, at MidiTec's 
option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE PRODUCT 
that does not meet MidiTec's Limited Warranty and which is returned to MidiTec or the supplier 
serving your country with a copy of your receipt. This limited Warranty is void if failure of the 
SOFTWARE PRODUCT has resulted from accident, abuse, or misapplication.

NO OTHER WARRANTIES. MidiTec disclaims all other warranties, either express or implied 
including but not limited to implied warranties of merchantability and fitness for a particular purpose, 
with respect to the SOFTWARE PRODUCT, the accompanying product manual(s) and written 
materials.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall MidiTec or its suppliers be 
liable for any other damages whatsoever (including, without limitation, damages for loss of business 
profits, business interruption, loss of business information, or other pecuniary loss) arising out of the 
use of or inability to use this product, even if MidiTec has been advised of the possibility of such 
damages. In any case, MidiTec's entire liability under any provision of this agreement shall be 
limited to the amount actually paid by your for the software. Because some jurisdictions do not allow 
the exclusion or limitation of liability for consequential or incidental damages, the above limitation 
may not apply to you.

Should you have any questions concerning this agreement, or if you desire to contact MidiTec for 
any reason, please write: MidiTec, Vegavaenget 26, DK  2620 Albertslund, Denmark. 
www.earmaster.com
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Appendix C

FAQ (Frequently asked questions)
There is no sound?

Go to the "Options" menu and choose"Program settings". On the "Devices" tab you can 
choose among different Output-devices. Choose one from the list, press OK and try 
one of the exercises. If this doesn't produce any sound, try to choose another from the 
list. At least one of them should produce some sound.

In some situations it can cause problems if more programs use MIDI at the same time. 
Please try to restart Windows and run EarMaster as the only program using MIDI.

Please also make sure that the Volume is set to max both the Windows MIDI volume 
and the EarMaster volume setting for Chords, Rhythm and Metronome. All of them can 
be changed in the EarMaster Program settings.

It doesn't sound very good, the chords are muddy - why?

EarMaster uses the sounds in your sound card. A sound card with wave table 
technology will give you a better sound. The best solution is to use a dedicated MIDI 
module.

The clap sound is delayed in the rhythm exercises - why? 

A sound card with Wavetable technology can give you a very good sound quality for the 
MIDI instruments. It is however  important that your sound card generates its instrument 
sounds from a hardware Wavetable, not a software Wavetable. Software Wavetable 
sound generation leads to annoying delays between pressing the spacebar, and 
hearing the sound.
Solutions:
1) EarMaster can compensate for some of the problems caused by the delay in your 
sound card, except the sound from the spacebar. If you can live without the clap sound 
from the spacebar then you can use this compensation. Choose the "Options" - 
"Program settings" menu item and find the "Devices" tab.
Here you can "Synchronize rhythms" by adjusting the delay.
2) Many sound cards also includes a MIDI driver based on FM synthesis. The sound 
quality is lower but there is no delay. You can try to change the MIDI output device in 
the EarMaster 'Program settings'.
3) If none of the above solutions are acceptable or possible then the only solution is to 
buy another sound card.

Can't get into the exercise setup - why is it disabled?

When the EarMaster Tutor is enabled it controls the exercise setup and then you 
cannot access it. To enable the exercise setup you need to stop the tutor: Go to the 
"File" menu remove the checkmark next to "Tutor".

How do I add sharps (#) and flats (b)? 

To add sharps and flats to the note sheet, click with the mouse on the sheet and hold 
down the mouse button while you move the mouse right (#) or left (b)
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Keyboard shortcuts in EarMaster

Many features in EarMaster can be controlled from the keyboard. 

Ctrl + 1 Interval comparison
Ctrl + 2 Interval identification 
Ctrl + 3 Chord identification 
Ctrl + 4 Chordinversion identification 
Ctrl + 5 Chord progression 
Ctrl + 6 Scale identification 
Ctrl + 7 Rhythm reading 
Ctrl + 8 Rhythm imitation 
Ctrl + 9 Rhythm correction 
Ctrl + 0 Melody dictate 

Shift + 1 Exercise
Shift + 2 Exercise setup
Shift + 3 Results
Shift + 4 User overview (Only teachers in EarMaster School)

F1 Help
Ctrl + F1 Context Help
F2 Load exercise setup
F3 Save exercise setup
F4 Tutor
Shift + F4 Tutor editor (Only for teachers in EarMaster School)

F5 New questions
F6 Play/Repeat question
F7-F8 Depends on specific exercise
F9 Stop
Shift + F9 MIDI all notes off
Ctrl + F9 MIDI reset controllers
Ctrl + F12 MIDI remote control
Ctrl + M Metronome sound (On/Off)

F10 Print results
F11 Class maintenance (Only for teachers in EarMaster School)

Shift + F2 Auto new question (On/Off)
Shift + F5 Answer by Notesheet
Shift + F6 Answer by name
Shift + F7 Answer by Piano
Shift + F8 Answer by Guitar
Shift + F11 Microphone input (On/Off)
Shift + F12 MIDI in (On/Off)

On the staff, sharps and flats can be added from the keyboard while holding the left 
mouse button:
z bb (double flat)
x b (flat)
c (natural sign)
v # (sharp)
b x (double sharp)

Ctrl + Delete Restart current exercise

 


